

    
      
          
            
  
Welcome to blendstudy’s documentation!

blenderを勉強するよ!!

決してグレート、という作例ではないですが「手順載せときますね」程度のもの。



	github

	https://github.com/lab1092/blendstudy



	read the docs

	http://blendstudy.readthedocs.org/en/latest/
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イントロダクション


Blenderとは?

Blenderとは3DCG統合環境。 以下のような機能を有しており、単体で3DCGの
映像制作ワークフローをカバーできるソフトウェア。


モデリング



	メッシュ


	Nurbs


	メタボール










レンダリング



	
	レンダラは2種類内蔵。外部レンダラとの連携も可能

	
	(Blender Internal)


	Cyclesレンダラ


















アニメーション



	パスアニメーション


	リギング


	頂点モーフ


	ドープシートによるアニメーション編集










コンポジット



	内蔵のノードエディタによる表現


	ビデオ編集機能


	モーショントラッキング


	カラーマネージメント










シミュレーション



	流体シミュレーション(Fluid)


	炎、煙のシミュレーション










ゲームエンジン



	Blender Game Engine










Pythonによる拡張(Add-on)



	標準で同梱されるAdd-on


	オンライン上にあるAdd-on












オープンムービープロジェクト


1.Elephants Dream(2006)



	プロジェクトURL

	http://orange.blender.org/











2.Big Buck Bunny(2008)



	プロジェクトURL

	http://www.bigbuckbunny.org/











3.Sintel(2010)



	プロジェクトURL

	http://www.sintel.org/











4.Tears Of Steel(2012)



	プロジェクトURL

	http://mango.blender.org/











monkaa(2014)



	ニュース記事URL

	https://cloud.blender.org/news/Monkaa%20Open%20Movie%20released











5.Cosmos Laundromat(2015)

2015年公開予定のプロジェクト。



	プロジェクトURL

	http://gooseberry.blender.org/
















          

      

      

    

  

    
      
          
            
  
アポロチョコを作成する

少しゆるめなBlender勉強会開催後＋ [https://lab1092.wordpress.com/2015/02/01/yurublend/]
で紹介した「アポロチョコ」のモデリング。



	Version

	2.73a



	キーワード

	ループ選択、マテリアル、スムース化、チェッカー選択、ナイフツール、ループカット、エッジスライド









完成図

[image: ../_images/apollo_001.png]
目標は「それなりに見えること」。今回の手順ではソリッドカラーのマテリアルを割り当てるのみで、
シーンセッティングまではしません。




開始


デフォルトキューブを消す

デフォルトキューブを消します。Cubeを選択した状態で[X]キーを押して削除します。

[image: ../_images/apollo_002.png]
[image: ../_images/apollo_003.png]
[image: ../_images/apollo_004.png]



新規オブジェクトの作成

Coneを追加します。その前に、追加する位置はグローバル座標原点にしたいので、
3Dカーソル(赤白の輪っか)を原点に移動させます。ずれている場合には[Shift]+[S]、
メニューから”Cursor to Center”を選択。

[image: ../_images/apollo_005.png]
メッシュの追加。[Shift]+[A]キーを押したメニューからMesh >Cone と選んで、”Cone”を追加します。

[image: ../_images/apollo_006.png]
[image: ../_images/apollo_007.png]



メッシュ編集

マウスホイールでコーンの表示を大きくします。次にエディットモードにして、底面を見える位置に視点を変更します。

[image: ../_images/apollo_008.png]
[image: ../_images/apollo_009.png]
[image: ../_images/apollo_010.png]
[A]キーで選択解除、[Alt]+[右クリック]でループ選択します。その状態で3Dビューのメニューから
Select > Checker Deselect を選択し、底部分の頂点が飛び飛びに選択されている状態にします。

[image: ../_images/apollo_011.png]
[image: ../_images/apollo_012.png]
選択状態を保持し、[S]キーを押してサイズを変更します。すると星型のような形になります。そこで確定。

[image: ../_images/apollo_013.png]
[A]キーで全ての頂点の選択を解除しておきます。

[K]キーを押し、[左クリック]を1回押してマウスを動かします。

[image: ../_images/apollo_014.png]
[image: ../_images/apollo_015.png]
直線が現れたところで[Z]キーを押し、非表示面も切る対象とします。

[image: ../_images/apollo_016.png]
[Ctrl]+[左クリック]で切断する場所を仮確定にします(辺の中点)。[Enter]キーで確定。

[image: ../_images/apollo_017.png]
[image: ../_images/apollo_018.png]
エッジスライド([G],[G])で、選択中の頂点を上に持ち上げます。

[image: ../_images/apollo_019.png]
Subdivision Surfaceモディファイアを適用します。
プロパティウィンドウのSpufaceボタンを押して出てくるAdd ModifierからSubdivision Surfaceを選択。

[image: ../_images/apollo_020.png]
[image: ../_images/apollo_021.png]
[image: ../_images/apollo_022.png]
ツールシェルフのSmoothボタンをおして面をスムーズに表示、Subdivision Surfaceの細分化のレベルを上げておきます。

[image: ../_images/apollo_023.png]
[image: ../_images/apollo_025.png]
底部分の星型を出すために、[Ctrl]+[R]でループカットを行います。[Ctrl]+[R]を押した後、
マウスを動かしてピンクの線が出てくるところで[左ボタン]クリックして、下方向にエッジを移動させて確定します。

[image: ../_images/apollo_027.png]
[image: ../_images/apollo_028.png]
[image: ../_images/apollo_029.png]
再度、[Ctrl]+[R]でループカットを行います。位置は適当に。ここがストロベリーチョコとミルクチョコの境界です。
.. image:: apollo_030.png

[image: ../_images/apollo_031.png]
[image: ../_images/apollo_032.png]
上の頂点に丸みが欲しいので、頂点を少し下げます。[G],[Z]か、マニピュレーターの青い矢印をドラッグするかで、頂点を移動します。

[image: ../_images/apollo_034.png]
[image: ../_images/apollo_035.png]



マテリアルの追加・割り当て

プロパティウィンドウのマテリアルボタンを押し、マテリアルの設定をはじめます。
マテリアルスロットの+ボタンを押して追加、さらに[+ New]ボタンを押して、
マテリアルを追加します。最初に設定したマテリアルはそのオブジェクトのデフォルトとして適用されます。

[image: ../_images/apollo_036.png]
[image: ../_images/apollo_037.png]
[image: ../_images/apollo_038.png]
[image: ../_images/apollo_039.png]
マテリアルカラーを設定します。

[image: ../_images/apollo_040.png]
[image: ../_images/apollo_041.png]
[image: ../_images/apollo_042.png]
次の作業のために下半分を選択します。limitvisibleボタンを押して、
隠れた部分の頂点も選択できる状態にし、[B]キーの領域選択で選択状態にします。

[image: ../_images/apollo_043.png]
[image: ../_images/apollo_044.png]
[image: ../_images/apollo_045.png]
マテリアルスロットの+ボタンを押して２つ目のマテリアルスロットを追加、マテリアルを追加します。

[image: ../_images/apollo_046.png]
[image: ../_images/apollo_047.png]
[image: ../_images/apollo_049.png]
2つ目のマテリアルを割り当てます。マテリアルスロットの下、Assignボタンを押します。
下半分の色が2番目のマテリアル色に変更されました。

[image: ../_images/apollo_050.png]
[image: ../_images/apollo_051.png]
一度エディットモードからオブジェクトモードにし、アングルを変えて確認します。
今のままでは縦に長いので、エディットモードで全選択([A])、[S]、[Z]でサイズ変更します。

[image: ../_images/apollo_052.png]
[image: ../_images/apollo_053.png]
完成です。

[image: ../_images/apollo_054.png]

Note

knifeコマンドについて、コマンド発行後の確定までの動きをきちんと把握しておきましょう。

knifeコマンド実行中、ヘッダ部分に表示される情報を確認しましょう。
(手順では[K]キーから始めていますが、[SHIFT]+[K]でも…)

knifeで「切る」というのには2種類あって、「クリックで直線を描いていく」、「ドラッグで自由に描いていく」方法があり、混在できます。(>2.73)



[EOF]









          

      

      

    

  

    
      
          
            
  
起動時BlenderPythonサンプル

Blenderは起動時にPythonスクリプトを指定することで、起動時に処理を行うことが可能です。

Contents:



	Blender起動時オプション
	コマンドラインからの実行





	OBJまたはFBXファイルを起動時に自動で開くサンプル
	サンプルコード





	BlenderでOBJファイルをFBXに自動変換して出力するサンプル
	サンプルコード













          

      

      

    

  

    
      
          
            
  
Blender起動時オプション

Blenderの起動時にオプションを渡すことで、自動化させたり、より高度なことが可能になります。


	note::

	blenderを起動時オプション付きで実行するには、ターミナルでコマンドラインを書くか、
スクリプト内に記載したファイルを実行する方法があります。






コマンドラインからの実行

コマンドラインオプションについて:



	https://www.blender.org/manual/render/workflows/command_line.html







blender --help などしても確認できます。


hoge.blendを読み込む

.blendファイルを読み込んで開くことが可能です。


c:\blender\blender.exe hoge.blend











バックグラウンド実行

バックグラウンド実行させることでblenderのGUIを開くことなく実行させることが可能です。
セットアップ済みシーンファイルのレンダリングを自動で行わせたい場合などに使用できます。

10フレーム目を出力:


blender -b file.blend -f 10








アニメーションを出力:


blender -b file.blend -a











スクリプト実行

特殊な処理を行いたい場合に、Pythonスクリプトを使用することも可能です。
OBJまたはFBXファイルを起動時に自動で開くサンプル や BlenderでOBJファイルをFBXに自動変換して出力するサンプル のようなことが可能です。

起動時にhoge.blend 内のテキスト、 testpy を使用する例:


blender hoge.blend -P testpy








起動時に外部ファイル test.py を使用する例:


blender hoge.blend -P test.py








[EOF]









          

      

      

    

  

    
      
          
            
  
OBJまたはFBXファイルを起動時に自動で開くサンプル

Blenderの起動時に指定したOBJファイルを自動的にインポートするサンプルです。



	Version

	2.73a



	キーワード

	Python,FBX ,OBJ



	OS

	Windows , OS X









サンプルコード

いろいろ考慮すべき部分を端折ってますので’サンプル’ということで。

なお、このコードを使ってどのように操作して使うかの説明は特にありません。


launchblender.bat


c:\blender\blender.exe -P C:\Users\username\desktop\test.py -- %1











launchblender.scpt


on main(input)
        try
                do shell script "/Applications/Blender274RC1/blender.app/Contents/MacOS/blender -P ~/Desktop/test.py --" & space & input
        end try
end main

on open argv
        repeat with aFile in argv
                main(quoted form of POSIX path of aFile)
        end repeat
end open

on run
        main(quoted form of POSIX path of (choose file))
end run











test.py


import bpy
import sys
import os


def delete_all():
        for item in bpy.context.scene.objects:
                bpy.context.scene.objects.unlink(item)

        for item in bpy.data.objects:
                bpy.data.objects.remove(item)

        for item in bpy.data.meshes:
                bpy.data.meshes.remove(item)

        for item in bpy.data.materials:
                bpy.data.materials.remove(item)


def launch_file(filepath):
        basename = filename = fileext = ext =''
        basename = os.path.basename(filepath)
        (filename,fileext) = os.path.splitext(basename)

        ext = fileext.lower()

        if os.path.isfile(filepath):

                if ext =='.fbx':
                        bpy.ops.import_scene.fbx(filepath=filepath,automatic_bone_orientation=True)

                elif ext =='.obj':
                        bpy.ops.import_scene.obj(filepath=filepath,axis_forward='-Z', axis_up='Y' )

                else:
                        None


if __name__ == "__main__":
        delete_all()
        launch_file(filepath=sys.argv[-1])








[EOF]









          

      

      

    

  

    
      
          
            
  
BlenderでOBJファイルをFBXに自動変換して出力するサンプル

Blenderの起動時に指定したOBJファイルを自動的にインポートし、
FBXファイルを出力するサンプルです。



	Version

	2.73a



	キーワード

	Python,FBX ,OBJ,ファイルフォーマット変換



	OS

	Windows , OS X









サンプルコード

いろいろ考慮すべき部分を端折ってますので’サンプル’ということで。


convfileblender.bat


c:\blender\blender.exe -P C:\Users\username\desktop\testconv.py -b -- %1











convfileblender.scpt


on main(input)
        try
                do shell script "/Applications/Blender274RC1/blender.app/Contents/MacOS/blender -P ~/Desktop/testconv.py -b --" & space & input
        end try
end main

on open argv
        repeat with aFile in argv
                main(quoted form of POSIX path of aFile)
        end repeat
end open

on run
        main(quoted form of POSIX path of (choose file))
end run











testconv.py


import bpy
import sys
import os

def delete_all():
    for item in bpy.context.scene.objects:
        bpy.context.scene.objects.unlink(item)

    for item in bpy.data.objects:
        bpy.data.objects.remove(item)

    for item in bpy.data.meshes:
        bpy.data.meshes.remove(item)

    for item in bpy.data.materials:
        bpy.data.materials.remove(item)

def convert_file(filepath):
    basename = filename = fileext = ext = outpath =''
    dirname = os.path.dirname(filepath)
    basename = os.path.basename(filepath)
    (filename,fileext) = os.path.splitext(basename)

    ext = fileext.lower()

    if os.path.isfile(filepath):

        # .obj -> .fbx
        if ext =='.obj':
            bpy.ops.import_scene.obj(filepath=filepath)

            outpath = os.path.join(dirname,filename+".fbx")
            bpy.ops.export_scene.fbx(filepath=outpath)

        else:
            None


if __name__ == "__main__":
    delete_all()
    convert_file(filepath=sys.argv[-1])








[EOF]









          

      

      

    

  

    
      
          
            
  
Blender Python Tips

Blender Python のTipsを。



	introduction







Contents:



	イントロダクション
	Blenderが使っているPythonのバージョンは?





	マクロとして使う
	ログが書かれている場所は?

	再現用スクリプトとして編集

	スクリプトの読み込み、実行





	Bpy tips
	ユーザー操作

	オブジェクト操作













          

      

      

    

  

    
      
          
            
  
イントロダクション

[ToDo]Blender Pythonについて簡単な説明を書く


Blenderが使っているPythonのバージョンは?

Pythonインタラクティブコンソールで確認できます。以下だと”3.4.2”ですね。


PYTHON INTERACTIVE CONSOLE 3.4.2 (default, Nov 25 2014, 12:01:44)  [GCC 4.2.1 Compatible Apple LLVM 6.0 (clang-600.0.54)]

Command History:     Up/Down Arrow
Cursor:              Left/Right Home/End
Remove:              Backspace/Delete
Execute:             Enter
Autocomplete:        Ctrl-Space
Zoom:                Ctrl +/-, Ctrl-Wheel
Builtin Modules:     bpy, bpy.data, bpy.ops, bpy.props, bpy.types, bpy.context, bpy.utils, bgl, blf, mathutils
Convenience Imports: from mathutils import *; from math import *
Convenience Variables: C = bpy.context, D = bpy.data








以下のようにPythonインタラクティブコンソールでコマンド実行しても確認は可能です。

そんなに頻繁に確認するわけでもない(というかPy3かどうかくらいの厳密さで十分)ので、
画面の操作でエディタータイプを変更して表示させるだけでいいかと。


>>> import sys
>>> sys.version
'3.4.2 (default, Nov 25 2014, 12:01:44) \n[GCC 4.2.1 Compatible Apple LLVM 6.0 (clang-600.0.54)]'














          

      

      

    

  

    
      
          
            
  
マクロとして使う

Blenderは操作の一部をログ出力しています。それらを切り出すことで
マクロのようなものとして使うことができます。


ログが書かれている場所は?

画面上部のメニューバーの上にあります。隠れているのでメニューバーの
下側を掴んで移動させて表示します。


[image: ../_images/useasmacro_001.png]



ログ出力は以下のように出力されます。


bpy.ops.mesh.primitive_monkey_add(radius=1, view_align=False, enter_editmode=False, location=(0, 0, 0), layers=(True, False, False, False, False, False, False, False, False, False, False, False, False, False, False, False, False, False, False, False))
bpy.ops.object.duplicate_move(OBJECT_OT_duplicate={"linked":False, "mode":'TRANSLATION'}, TRANSFORM_OT_translate={"value":(3, 0, 0), "constraint_axis":(True, False, False), "constraint_orientation":'GLOBAL', "mirror":False, "proportional":'DISABLED', "proportional_edit_falloff":'SMOOTH', "proportional_size":1, "snap":False, "snap_target":'CLOSEST', "snap_point":(0, 0, 0), "snap_align":False, "snap_normal":(0, 0, 0), "gpencil_strokes":False, "texture_space":False, "remove_on_cancel":False, "release_confirm":False})
bpy.context.space_data.context = 'MATERIAL'
bpy.ops.material.new()
bpy.context.object.active_material.diffuse_color = (0.8, 0, 0.00109809)
bpy.context.object.active_material.diffuse_color[2] = 0
bpy.context.object.active_material.diffuse_color[0] = 1
bpy.context.object.active_material.diffuse_color = (1, 0, 0)








出力ログをコピーする場合には、以下の操作を行います。



	該当の行を右クリック選択(選択行の色が変わります)


	選択された状態で [Ctrl]+[C] を押してクリップボードにコピーします。










再現用スクリプトとして編集

上記を少し整理して書くと以下のようになります。 usermacro.py という名前で保存します。


import bpy

bpy.ops.mesh.primitive_monkey_add()
bpy.ops.object.duplicate_move(OBJECT_OT_duplicate={"linked":False, "mode":'TRANSLATION'}, TRANSFORM_OT_translate={"value":(3, 0, 0)})
bpy.context.space_data.context = 'MATERIAL'
bpy.ops.material.new()
bpy.context.object.active_material.diffuse_color = (1, 0, 0)









Note

スクリプト実行前の状態と実行後の結果についてきちんと把握しておいてください。
また、再実行する可能性があるか、その際に留意することは何か、についても。




Note

ログ中の情報で何が必要で何が必要でないかについては自身で決めてください。






スクリプトの読み込み、実行

Blenderのテキストエディタに保存したPythonスクリプトを読み込んで実行します。

テキストエディタにスクリプトを読み込んだ状態でメニューから
Text > Run Script ([Alt]+[P])を実行します。


Note

コマンドラインオプションから保存したファイルを指定して実行させることも可能です。









          

      

      

    

  

    
      
          
            
  
Bpy tips


ユーザー操作


blenderを終了する


bpy.ops.wm.quit_blender()













オブジェクト操作


モンキーを追加する

Add Mesh > Monkey と同じことを行います。


bpy.ops.mesh.primitive_monkey_add()











選択されたオブジェクトを取得する

Blenderの画面上で「アクティブ」と「選択されている」という二つの状態があります。

たとえば’Camera’, ‘Empty’, ‘Lamp’のオブジェクトがあるとして…


>>> bpy.data.objects
<bpy_collection[3], BlendDataObjects>

>>> bpy.data.objects.keys()
['Camera', 'Empty', 'Lamp']








アクティブなオブジェクトは以下で取得可能です。


>>> bpy.context.object
bpy.data.objects['Empty']








選択されたオブジェクトは以下で取得可能です。


>>> bpy.context.selected_objects
[bpy.data.objects['Empty'], bpy.data.objects['Camera']]








ちなみに、選択可能なオブジェクトはどうやったら確認できるか、というと


>>> bpy.context.selectable_objects
[bpy.data.objects['Empty'], bpy.data.objects['Camera'], bpy.data.objects['Lamp']]











オブジェクトを選択する

スクリプトからオブジェクトを選択することも可能です。

3Dビューのメニュー、Select > Select All by Type… > Empty と同等のコマンド


>>> bpy.ops.object.select_by_type(type='EMPTY')
{'FINISHED'}








オブジェクトの選択状態を保持するプロパティを変更して選択状態にします。


>>> bpy.data.objects['Camera'].select
False

>>> bpy.data.objects['Camera'].select = True
>>> bpy.data.objects['Camera'].select
True











オブジェクトの親を取得する


[image: ../_images/tips_001.png]



(少し冗長に書きます)


>>> bpy.data.objects
<bpy_collection[3], BlendDataObjects>

>>> bpy.data.objects.keys()
['Camera', 'Empty', 'Lamp']

>>> bpy.data.objects['Camera']
bpy.data.objects['Camera']

>>> bpy.data.objects
<bpy_collection[3], BlendDataObjects>

>>> bpy.data.objects.keys()
['Camera', 'Empty', 'Lamp']

>>> bpy.data.objects['Camera']
bpy.data.objects['Camera']

>>> bpy.data.objects['Camera'].parent
bpy.data.objects['Empty']

>>> bpy.data.objects['Camera'].parent_type
'OBJECT'
















          

      

      

    

  

    
      
          
            
  
Blenderで使えるモジュールを調べてみよう

http://lab1092.blog.jp/archives/51891633.html から。


Blenderで使えるモジュールを調べてみよう

今回はBlenderのPythonで使えるモジュールを調べてみることにします。
やっていることはBlenderっぽくないですが、「Pythonの基本的なところを学習する環境としても使える」ということをわかってもらえるといいんじゃないでしょうか。

以下のBlog記事で紹介されているものをBlender上のPython Interactive console上で、というわけですね。



	利用可能なモジュール一覧を取得する [http://tell-k.hatenablog.com/entry/2012/02/04/131805]








ロード済みモジュールを確認

ロード済みモジュールを確認するには、 sys.modules.keys() を実行します。


>>> import sys
>>> sys.modules.key()











利用可能なモジュールを確認

Blenderに同梱されているPythonのライブラリは、「標準ライブラリ(流石にTKはありません)」+αです。これを一覧で確認します。


>>> buf=[]
>>> for m in pkgutil.iter_modules():
...     buf.append(m[1])
...
>>> buf.sort()
>>> buf








これで確認してみると…。xmlrpcとかnumpy…えっ?numpy???




「何をするものか」を確認

さて、一覧が取得できても、個々に「何をするもの」かまでは名前からだけではわかりません。そこで help() 関数。 以下のように実行してみます。


>>> import xmlrpc
>>> help(xmlrpc)
Help on package xmlrpc:
NAME
    xmlrpc - # This directory is a Python package.
PACKAGE CONTENTS
    client
    server
FILE
    /Applications/Blender/blender.app/Contents/Resources/2.74/python/lib/python3.4/xmlrpc/__init__.py








パッケージやモジュール、関数に help() 関数を使ってみると説明が表示されるので良さげです。


  
    
    Misc
    

    
 
  

    
      
          
            
  
Misc

その他事項:

Contents:



	Blenderの新しいマニュアルドキュメント
	2.7x用のドキュメントはSphinxベース

	マニュアルトップページ

	新しいBlenderマニュアル、翻訳関連メモ
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Blenderの新しいマニュアルドキュメント


2.7x用のドキュメントはSphinxベース

Please Check:



	https://developer.blender.org/project/view/53/


	bf-docboard [http://lists.blender.org/mailman/listinfo/bf-docboard]







2014/10/30現在、「英語ドキュメントを優先」の模様ですが…。




マニュアルトップページ

Blender公式のマニュアルは2.4及び2.6がWiki形式で、2.7からのマニュアルがSphinxベースでそれぞれ存在しています。



	Ver 2.4 英語 [http://wiki.blender.org/index.php/Doc:2.4/Manual]


	Ver 2.4 日本語 [http://wiki.blender.org/index.php/Doc:JA/2.4/Manual]


	Ver 2.6 英語 [http://wiki.blender.org/index.php/Doc:2.6/Manual] 英語


	Ver 2.6 日本語 [http://wiki.blender.org/index.php/Doc:JA/2.6/Manual]


	Ver 2.7 英語 [http://www.blender.org/manual/]


	Ver 2.7 の日本語マニュアルはまだありません。







新しいSphinxペースのマニュアルは「英語版をちゃんと表示できること」が優先されている模様。




新しいBlenderマニュアル、翻訳関連メモ

BFのプロジェクト:



	blender公式のドキュメントプロジェクト [https://developer.blender.org/project/view/53/]







日本語翻訳関連(2.7)の古い記録:



	Ver 2.7 [http://blender-manual-i18n.readthedocs.org/ja/latest/contents.html] 日本語(テスト)
これは「日本語翻訳できるかどうか」を確認するためのページです。


	ドキュメントをコンパイルしたはなし [https://github.com/lab1092/blendermisc/blob/master/blenderdoc53_ja.rst]













          

      

      

    

  

  
    
    Appendix
    

    
 
  

    
      
          
            
  
Appendix

その他事項:

Contents:



	Blenderとテンキーの話
	Blenderは「テンキーがないと使えない」?





	Mac Book Pro で使う簡単blender
	blenderって本当にMBPで使うと簡単なの？





	Pieメニュー(2.72)
	標準でPieメニューが搭載されました。
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Blenderとテンキーの話


Blenderは「テンキーがないと使えない」?

Blenderでは視点の切り替えに使用するテンキー。ただ、ノートPCだと、テンキーを省いた
キーボードレイアウトであることが多く、「どうすればいいの?」となることがあります。

テンキーがない場合にどうするかということについて書いていきたいと思います。


1.外部接続のテンキーを購入する

はい、ハードウェアを入手します。「無ければ追加購入する」、これが王道です(にっこり



	ノートPCなのでテンキーが使えないのですが [http://blenderfaq.blender.jp/oldfaq/problem/noto-pcna-node-tenki-ga-tsukae-nai-no-desu-ga]







有線(USB)、無線などの接続方法があり、ものによってはドライバーのインストールが必要なもの
もあります。




2.’Emulate Numpad’機能を有効にする

ユーザープリファレンス画面の’Emulate Numpad’を有効にすることで、キーボード上段の
数字キーをテンキー操作に割り当てます。








	1

	フロントビュー



	3

	サイドビュー



	7

	トップビュー



	0

	カメラビュー









レイヤー切り替えの代わりに視点切り替えにするわけですね。

選択されたものを表示’View Selected’([テンキー.]) についてどこに割り当てようか、と思案のしどころでしょうか。

参照:



	http://www.blender.org/manual/preferences/input.html#numpad-emulation


	http://www.blender.org/manual/getting_started/installing_blender/configuration.html#input










3.’Pie Menus’ Add-onを使う

Blender 2.72 から ‘Pie Menus’ が標準Add-onで付いてくるようになりました。
ただし、デフォルトでは無効の設定になっているので、これを有効にする必要があります。



	Pieメニュー(2.72)










4.’Blender keypad’を使う

「物理的なテンキー」を別途購入するまでもないかな、という場合に’Blender keypad’が
使えるかもしれません。iPhone/iPad/iPot touchと無線ネットワーク接続できる環境が必要です。



	
	Blender KeyPad

	
	https://itunes.apple.com/us/app/blender-keypad/id430784289?mt=8


















5. ‘3D Navigation’ Add-onを使う

標準Add-onの ‘3D Navigation’ を有効にすると 3Dビューのツールシェルフに
‘Navigation’タブが出現します。そのタブ内のボタンでビュー操作が可能です。
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Mac Book Pro で使う簡単blender


blenderって本当にMBPで使うと簡単なの？


そんな事はありませんよ！！

でも、どうにかしてblenderさんを使えるようになりたいんですね。

MBPで複数のblenderを起動させる

Blender: Multi-Instances on Mac OSX( http://www.iamklaus.org/2013/01/02/blender-multi-instances-on-mac-osx/ ) に書いてあった方法。
ターミナル上から、コマンドラインに以下を指定して起動。 “open -n” がミソの様子。

open -n /Applications/Blender/blender.app





アプリケーションの切り替えとかは[CMD]+[TAB]とかで。

でもね、最初のうちは１つだけ起動(アイコンをクリック)でいいですよ…

トラックパッド、結構使える

MacBook Pro のマルチタッチトラックパッドに対応してんですよ、blenderさん。



	
	指二本

	
	ピンチイン、アウト(3Dビューだけじゃない、他も大きさ変えられるからやってみて)


	スクロール(¥*1)


	回転















注意点(¥*1): えーと、二本指スクロールさせるときに撥ねるようにすると、ピンチイン、アウトに慣性がついたようにになります。(これはトラックパッドの設定から切る事は出来ます。)

勢い良く3D空間が拡大、縮小されてシーンをよく見失うので注意してね。 見失った場合には[Shift]+[c]でだいたい復帰出来ますね。

MBPとかで設定する項目

「システム環境設定」のキーボード＞キーボードショートカット で、 F* キーを 音量だとかのコントロールから解放してあげましょう。

次にテンキーが無いMBPなどの環境用。blenderの User Preference (ショートカットキー [Cnd]+[.])から、



	Emulate Numpad







をチェックしてあげるといいかもです。まあ、blenderの3Dビューにおける視点変更は大事な要素ですので
お金と机のスペースに余裕があるようでしたら、テンキーの購入も検討されては。

別解として、2.72から標準で入っているAdd-on Pieメニュー を有効にすることでも。
むしろこちらをおすすめします。

有効にするAdd-on

同じく、blenderの User Preference (ショートカットキー [Cnd]+[.])から、Addons タブを選択、



	3D View: Dynamic Spacebar Menu







これを有効にすることで、Spaceキーのメニューに “Add Object Menu” とかが現れます。

一通り設定が終わったら

上記でUser Preferenceを設定したら、User Prefernce 画面から [Save]ボタン、または[Ctrl]+[U]キーを
押して、blenderの現在の設定を保存します。


Note

好きなときに[Ctrl]+[U]を押す事で、その画面設定を次回起動時の設定としていつでも保存が可能ということ。



変な風にプリファレンス設定を保存してしまった場合

Fileメニューから、Load Factory Settings を選んでください。

マウスについて

中ボタン必須。トラックパッドでも視点移動などの操作が可能とはいえ、細かい部分や視点移動のスムーズさではマウスに
かなわない部分があります。もっとも、他のデバイス(タブレットや3Dマウス)等を併用する事も可能ではありますが。

Windowsから移行してきたんだけど

常に複数のバージョンを使ってるとかそういう状況ではWindowsの方が簡単だったりするのですが…。あれですかね?やっぱりドヤりたいとかでしょうか？

とりあえず異なるOS間の差分をチェックしておけばいいと思います。ショートカットとかその辺も含めて大体同じですが、ファイルパスとかその辺で詰まってしまうかも。



	ファイルパスの区切り文字が違いますね


	[Ctrl]+[Alt]って効かないのかな、とか[Ctrl]+[1],[Ctrl]+[2]とか効かないとかその辺は気にしない


	ユーザーフォルダとかちゃんと把握しておくとトラブル時に役に立ちます。 Help>System info 実行して確認。


	Nvidia積んでないorパフォーマンスが上がらないとかよく分からないです。
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Pieメニュー(2.72)


標準でPieメニューが搭載されました。

2.72からPieメニューが搭載されました。2.73で少し変化がありました。


Pieメニューを有効にしてみます

blenderを起動したら、infoウィンドウのメニューから、 File –> User Preference と選びます。

Add-ons ボタンをクリックし、 検索窓に pie と入力します。

右側のリストに User Interface: Pie Menu Official が絞り込まれて表示されているはずですので、この右端の
チェックボックスをクリックしてチェックを入れます。

これでpieメニューが有効になりました。




キーカスタマイズ

次に、キーをカスタマイズします。TabキーとZキーはpieメニューを無効にしておきたいためです。

画面右の検索窓に pie と入力します。

“Call Pie Menu”の項目がいくつか出てきます。



	Z　-> 無効にする


	Tab -> 無効にする







設定が終わったら Save User Preference ボタンを押して次回起動時に変更が保持されるようにします。




参照



	http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/3D_interaction/Pie_Menu
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My Videos

少しだけアップロードしてますが、作品らしいものはないですね…


ボールコースター

ボールがレールの上を転がっていく様子。物理演算の機能を使ってます。



	URL

	https://player.vimeo.com/video/120949643



	BlenderVersion

	2.73a
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Pythonインタラクティブコンソール

[Todo]コンソール関連情報


import thisを実行

‘Zen of Python’を表示します。


>>> import this
The Zen of Python, by Tim Peters

Beautiful is better than ugly.
Explicit is better than implicit.
Simple is better than complex.
Complex is better than complicated.
Flat is better than nested.
Sparse is better than dense.
Readability counts.
Special cases aren't special enough to break the rules.
Although practicality beats purity.
Errors should never pass silently.
Unless explicitly silenced.
In the face of ambiguity, refuse the temptation to guess.
There should be one-- and preferably only one --obvious way to do it.
Although that way may not be obvious at first unless you're Dutch.
Now is better than never.
Although never is often better than *right* now.
If the implementation is hard to explain, it's a bad idea.
If the implementation is easy to explain, it may be a good idea.
Namespaces are one honking great idea -- let's do more of those!

>>>











クラスメンバや関数の表示

インタラクティブコンソールでは[Ctrl]+[Space]の補完で表示させることもできますが、
dir() を使って表示できます。


>>> bpy.data.meshes.
                                        as_bytes(
                                        bl_rna
                                        data
                                        find(
                                        foreach_get(
                                        foreach_set(
                                        get(
                                        id_data
                                        is_updated
                                        items(
                                        keys(
                                        new(
                                        new_from_object(
                                        path_from_id(
                                        remove(
                                        rna_type
                                        tag(
                                        values(
>>> dir(bpy.data.meshes)
['__bool__', '__contains__', '__delattr__', '__delitem__', '__doc__', '__doc__', '__getattribute__', '__getitem__', '__iter__', '__len__', '__module__', '__setattr__', '__setitem__', '__slots__', 'bl_rna', 'find', 'foreach_get', 'foreach_set', 'get', 'is_updated', 'items', 'keys', 'new', 'new_from_object', 'remove', 'rna_type', 'tag', 'values']

>>>
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大見出し:テンプレート


中見出し:テンプレートファイルです。


小見出し

そのほかの見出し



	Bullet





	ナンバリング
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